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 2012 Jörg Golombek 

All rights reserved. 

The company Jörg Golombek reserves the right to change or modify the device in order to improve and develop it 

technically. Such changes or modifications will not be documented in each single case. This operating manual and 

the information contained therein have been drawn up and compiled carefully. Any reproduction, in full or in part, 

requires the prior consent of the company Jörg Golombek. 
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Device Film analysis  Identification data 

 
 
 
 

Inventory number   Customer information 

Equipment 
number 

   

Location    

 
 
 
 

Company name Jörg Golombek  Operator address 

    

Street Eichhäldenstr. 73   

    

Place D-71720 Oberstenfeld   

    

Telephone +49 (0)7062  5607   

    

Fax +49 (0)7062  3873   

    

E-mail: info@folienanalyse.de   

    

Website www.folienanalyse.de   

 
 
 

 For address see above  Spare parts and 
customer service 
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Document information 
Document number of 
operating manual 

 

   

 Version  

   

Original manual Draft date  

   

 Latest revision  

 
 
 
 

Purpose of 
document 

This operating manual intends to make familiar the device 
operator with 

• its mode of operation; 

• its operation; 

• the safety instructions; and 

• its maintenance. 

 

Operating personnel 

 

The device must be operated by instructed and trained 
personnel only who is familiar with function, operation and 
safety instructions of the device. 
Such instructions must be documented in the acceptance 
certificate. 

 

 

NOTE! 
 

Always keep this operating manual near the device! 

This manual must be within reach at any time!  
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1 Safety instructions 
 
This operating manual contains important information on how to analyse films safely and 
economically. 
 

1.1  Obligations and liability 
• A basic requirement for the safe handling and fault-free operation of this device is 

knowledge of the fundamental safety instructions and safety regulations. 
• This operating manual, including but not limited to the safety instructions therein, must 

be observed by all persons working on and with the device. 
• In addition, accident prevention rules and regulations valid for the site of operation must 

be observed. 
• The device has been built to the state of the art and in accordance with the generally 

accepted safety regulations. Nevertheless, can its use be dangerous for the operator or 
a third party, or impair the device or other material assets. Therefore, the device may be 
used only: 

 
� for its intended purpose; 
� And in good order and condition as regards the safety equipment. 

 
• In case of malfunctions that may impair the device's safety the device must be shut off 

and the fault must be corrected; only then the device may be switched on again. 
• Any warranty or liability claims for personal injury or property damage shall be excluded 

if resulting from one or more of the reasons listed below: 
 

� Use of device other than its intended use; 
� Improper installation, commissioning, operation and maintenance of the 

device. 
� Operation of the device with defective safety equipment or not appropriately 

applied or non-functional safety and protective equipment; 
� Non-observance of notes and instructions in this manual as regards 

transport, storage, installation, commissioning, and maintenance of the 
device; 

� Unauthorised changes to the machine; 
� Unauthorised changes to the performance or drive conditions of the device. 
� Poor inspection of device parts that are subject to wear; 
� Improperly performed repairs; 
� Improperly performed cleaning jobs (for example, high-pressure cleaning); 
� Disaster situations resulting from force majeure or acts of God. 
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1.2 Safety icons 
 
In this operating manual, we use the following descriptions and icons for hazards: 
 

 

GEFAHR 
 

This icon indicates an immediate danger for life an d health of a 
person. 

Failure to observe such notes or instructions results in severe 
damage to health, including life-threatening injury or death. 

 
 

 

 

GEFAHR 
 

This icon indicates an immediate hazard through ele ctric 
energy. 

Failure to observe such notes or instructions results in severe 
damage to health, including life-threatening injury or death. 

 
 

 

 

WARNUNG 
 

This icon indicates possible dangers for life and h ealth of a 
person. 

Failure to observe such notes or instructions may result in severe 
damage to health, including life-threatening injury or death. 

 
 

 

 

VORSICHT 
 

This icon indicates possibly dangerous situations f or persons 
or damage to property. 

A failure to observe such notes or instructions may result in slight 
injuries or property damage. 

 
 

 

 

NOTE!  

Icon and note indicate tips for use and other usefu l 
information. 
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1.3  Hazard pictograms 
 
 

 

Mechanical hazards, such as squeezing, shearing, friction, 
abrasion, etc. 

 
 

 

Danger through motor-
clothing may be drawn in. Do

 
 

 

Danger through electrical equipment on device.

 
 

 

Danger through hot media.

 
 

 

Combined hazards. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mechanical hazards, such as squeezing, shearing, friction, 

-driven components. Body parts or pieces of 
clothing may be drawn in. Do not remove any protective covers. 

Danger through electrical equipment on device. 

Danger through hot media. 

driven components. Body parts or pieces of 



  

 

1.4 Mandatory action signs
 
 
You must wear personal protective equipment (PPE) when working on 
 
 

 

Wear safety shoes!

 
 

 

Wear safety gloves!

 
 

 

Wear safety goggles!

 
 

 

Wear protective clothing!

 

  

 

Mandatory action signs  

You must wear personal protective equipment (PPE) when working on 

Wear safety shoes! 

Wear safety gloves! 

Wear safety goggles! 

Wear protective clothing! 
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You must wear personal protective equipment (PPE) when working on device. 
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Wichtig  

 

1.5  Intended use 
 
We can guarantee operational safety of this device/system only if used as intended.   
The device may only be used for analysing films within the limits defined below.  
 
The device may be used for analysing films with the following properties:  
 

Material  Resin-coated or varnished paper 

  

Width  60 mm  

Height  96 mm  

Weight of raw paper: 30 g/m² - 150 g/m² 

 
 
Only if these criteria are met the device is deemed used as intended. 

 
Intended use also includes: 

• Observance of all notes in this operating manual and 

• Compliance with all inspection and maintenance requirements. 
 
 

The device must not be used to analyse thermoplasti c 
highly combustible films. This may result in danger  for 
persons or damage to the device. 

 
 

1.6 Inappropriate use 
 
The device must not be used other than listed above because any inappropriate use may 
lead to risks for persons working on or near the device, who may incur injuries, or may 
cause damage to the device. 
Heating of food or other objects (expect for above films) is prohibited. 
 
The operator alone bears the consequences of 
 

� any not intended use; 
� activities not described in this operating manual. 

 
The manufacturer does not accept any liability for any damage resulting thereof. In case of 
not intended use, any liability claims to the manufacturer shall be forfeited. 
 

 
1.7 Limitations of device 
 
The device is suited for analysing films within the described temperature range and in the 
approved liquid: 

NOTE! 
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� Use  "Silikonöl TYP 350 für Folienanalyse"  (Silicone oil type 350 for film analysis) 

only! Use of other silicone oils may lead to inaccurate results or damage the device. 
 
 
Analysis is impossible or impaired: 
 

� if inappropriate media are used. 
 
 

1.8 Organisational measures 
 
The operating company must provide the necessary personal protective equipment and 
such PPE must always be functional. 
All existing safety equipment must be checked and examined regularly. 
All employees must be advised of the risks at their workplaces regularly. 

 

 

1.9 Safety equipment 
 
• Before you start the device, all safety equipment must be correctly installed and fully 

functional. 
• Any safety features may be removed only after shutting down the device by specialised 

personnel, for maintenance, cleaning or repair purposes. 
•  If device components are shipped or fitted later on, the safety equipment must be 

attached by the operator in accordance with instructions. 
 
 

1.10 Informal safety measures 
 
• This operating manual must be kept at a place where it can be consulted at any time. 
• In addition to the operating manual, all general and local regulations as regards power 

supply, accident prevention, operational safety and environmental protection must be 
provided for reference and complied with. 

• All safety instructions and hazard warnings on the machine must be kept legible and must 
be replaced if necessary. 
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1.11 Safety measures in normal mode of operation 
 
Operate the machine only if all safety equipment is fully functional. Prior to switching on, make 
sure that no person is at risk through starting device. 
In regular intervals, the device must checked for any visible damage and for the safety 
equipment's proper functioning. 

 

 

1.12 Hazards through electric energy 
 
• Only skilled electricians are authorized to carry out work on the electric system. 
• Electrical equipment of the device must be checked regularly. 
• If there are any defects on the electrical equipment, the device must be switched off 

immediately and the defect must be repaired by a skilled electrician. 
• The device must only be started again after the electrical equipment has been checked and 

found faultless. 
 
 

1.13 Specific hazards 
 
• Squeezing and shearing hazard at individual device parts. 
• Voltage hazard and risks at electrical equipment. 
• Use of hazardous materials. 
 
 

1.14 Preventive and corrective maintenance, trouble shooting 
 
• Carry out prescribed adjustment, preventive and corrective maintenance as scheduled. 
• All operating media such as electric, heating and drive systems must be secured against 

unintended start. 
• While preventive or corrective maintenance jobs or repair jobs are carried out on the 

device, it must be fully de-energised and the main switch must be secured against 
unauthorised switching on.  

• Upon completion of maintenance work and prior to switching on again, check correct 
function of safety equipment. 
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1.15 Cleaning of device and disposal 
 
Used supplies and materials must be properly handled and disposed. This applies, 
including but not limited to: 
 

� the cleaning of the device; 
� and when replacing parts. 

 
 

1.16 Device noise 
 
• The noise emission level of the device is < 50 dB(A) (DIN EN 60704-1). 
 
 

1.17 Accident prevention regulations, industrial sa fety 
regulations 

 
• All applicable accident prevention regulations and industrial safety regulations must be 

complied with at any time. 
• In case of any accident or failure, the device must be shut off at the main switch 

immediately. 
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2 Device description, technical data 
 

2.1 Overall view  device for film analysis 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Image 1 Complete device 

 

2.2 Workplaces 
 
The device must be used by a single person only. The workplace is at the front side of the 
device. 
 

 
The device operator must take care that the workplace is free of any objects 
that may represent risks. 
 

 

2.3 Hazard zones 
 
All hazards in connection with the device are listed in the risk assessment and the necessary 
measures for avoiding hazards have been carried out. 
 
However, there may still be residual risks in connection with the device. Therefore, all safety 
instructions and warnings in the operating manual and on the device must be noted and 
observed in any case. 

 

NOTE! 
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2.4 Device labelling  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1:  Type plate with CE marking 

  

Type:  
Device for Film 
Analysis 
Serial No.: XXXXXXX 
Manufactured:XX.XXXX Meß- u. Analysensysteme 
Jörg Golombek 
Eichhäldenstr. 73 
71720 Oberstenfeld 
Germany 



Film analysis 

Page 18 of 68 

 
 

2.5 Technical data 
 
General data   

  
Device L x W x H (mm) 450 x 450 x 600 
  
Weight: approx. 30 kg 
  

Table 1 

 
 
Power supply / electrics   
  
Operating voltage AC 230 V, 50Hz 
  
Main fuse 16 A delayed 
  

Table 2 

 
 
Process data   
  

--- Duration of analysis: 2.0 – 30 minutes 
  
Supplies (approx.) Silicone oil     
     
     
     
     

Table 3 

 
Environmental conditions  Operation 
Room The device must be operated indoor only, in a 

frost-free room. 
The device must not be used in potentially 
explosive environments. 

Temperature min. 5 °C, max. 40°C  
Humidity max. of 90 % relative humidity 

Table 4 

 
Environmental impact   
  
Noise level at device < 50 dB(A) (DIN EN 60704 – 1) 

Table 5 
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3 Design and function of device  
3.1 Mechanical design  and lLegend 
 
 
 
 
Figure 2: 
 
 

 
 
 
 
  

Measuring 
head 

Tempering bath 

Specimen 
holder 

Specimen 

Power switch 

Opening 
tempering bath 

Display for 
temperature and 
settings 

Operator buttons 

Tower with guide rail 
and drive for moving 
up and down 
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4 Transport and storage
 
4.1 Means of transport 

A suitable jack lift is required for device transport.
Such jack lift must be suited for the device's weight and dimensions.
(For this, see section "Technical data").

 

4.2 Safety instructions for transport
 

 

 

Falling Load Hazard

May result in severe injury and property damage.

Lift up or transport machine only using lifting gear that is suited 
for the weight and dimensions of the device.
� Mind information in technical data.
� Do not transport device using a crane.
� Do not incline device during transport. Due to its
 high centre of mass, the device may tilt over easily.
� Make sure to balance the centre of mass 
� Do not reach under the device while putting down the load.

 
 

   W A R N I N G
 

 

 
Transport, dismantling and assembling of device by skilled and 
trained personnel only.

 
 

4.3 Preparing for transport 
 

1. If the device has been 
transport. Liquid in bath must be cooled down and filled in a suitable container.

2. Check condition and load bearing capacity of intended installation location and 
of entire transport path.

  - Install device on plane and stable base only.
  - Observe all local applicable regulations for working rooms.
  - Take note of all technical data of device.
 3. Determine and mark exact installation location.
 4. Determine transport path and remove any obstacles.
 5. Keep away unauthorised persons from transport path and installation location.
 6. Close areas, if necessary.
 
 

Transport and storage  

A suitable jack lift is required for device transport. 
Such jack lift must be suited for the device's weight and dimensions. 

this, see section "Technical data"). 

Safety instructions for transport  

W A R N I N G 

Falling Load Hazard 

May result in severe injury and property damage. 

Lift up or transport machine only using lifting gear that is suited 
and dimensions of the device. 

Mind information in technical data. 
Do not transport device using a crane. 
Do not incline device during transport. Due to its 
high centre of mass, the device may tilt over easily.
Make sure to balance the centre of mass during transport.
Do not reach under the device while putting down the load.

W A R N I N G 

Transport, dismantling and assembling of device by skilled and 
trained personnel only. 

transport  

If the device has been operated already, it must be decommissioned prior to 
transport. Liquid in bath must be cooled down and filled in a suitable container.
Check condition and load bearing capacity of intended installation location and 
of entire transport path. 

device on plane and stable base only. 
Observe all local applicable regulations for working rooms. 
Take note of all technical data of device. 

Determine and mark exact installation location. 
Determine transport path and remove any obstacles. 
Keep away unauthorised persons from transport path and installation location.
Close areas, if necessary. 

 

Lift up or transport machine only using lifting gear that is suited 

 
high centre of mass, the device may tilt over easily. 

during transport. 
Do not reach under the device while putting down the load. 

Transport, dismantling and assembling of device by skilled and 

operated already, it must be decommissioned prior to 
transport. Liquid in bath must be cooled down and filled in a suitable container. 
Check condition and load bearing capacity of intended installation location and 

Keep away unauthorised persons from transport path and installation location. 
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4.4 Transport original packing 

 
Observe the safety instructions in chapter 4.2 and the loading and  
transport instructions on the device! 
 
For transport by truck, be sure to chose a safe location and fix the device safely 
on the platform. 
 
Upon arrival, check device for any obvious transport damage. If you notice any 
defect, report it to the carrier immediately. 
 
The device is shipped in its original packing, on a pallet or in a crate, and it 
should stay that way as long as possible on its way to its installation location. 
 
The device must not be turned over or inclined by more than 5° horizontally. 
 
For the device's gross weight including original packing, see Technical Data 
section of this operating manual. 

 
 

4.5 Transport unpacked 
 

� See and observe safety instructions in chapter 4.2! 
 
Requirements 
 

� No liquid in device. 
� Main switch switched off and any energy supply disconnected. 

 
Procedure 
 

1. Check and secure transport path, and remove any obstacles. 
2. Carry all components to installation location individually, one by one. 
3. Transport of device to its installation location should be as close as 

possible to the floor. 
4. Put down device slowly and carefully. In doing so, do not reach 

underneath the load. 
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Wichtig  

 

5 Installation and commissioning
 
5.1 Install device 

 
The device must not be operated in a potentially explosive environment or where 
there is a risk of frost. 
Its analysing performance is heavily limited with an ambient temperature of less 
than 15°C. Chose a s uitable installation location.
Do not operate the device in an environment in which, for example, acids are 
used to clean other parts. Various acids may cause pitting corrosion on device 
parts. 
 

 
Prerequisites   
 
 The device's installation location must be 

plane. 
 All local applicable safety provisions and regulations must be complied 

with. 
  
 
 
Procedure 
 

1 Place device at its final location. For this, also see transport instructions in 
chapter 4.6. 

2 Device must be leveled out 
 
5.2 Connect to power supply
 

 

 

Electrical hazard

This may result in fatal electrocution.

� Connect electrical connections in accordance with the 
wiring diagram and the information on the type plate.

� Device must be 
isolated ground receptacles (PE) only!

� The mains plug serves as safe separation from mains.
� and must always be freely accessible at any time.
� Do not operate device with damaged power cord.
� Power cord must be regularly
� No liability accepted in case of improper power connection!
� In accordance with all valid standards at the installation 

location, for example VDE 0100,
this may be done by a skilled

 
 

NOTE! 

Installation and commissioning  

The device must not be operated in a potentially explosive environment or where 

Its analysing performance is heavily limited with an ambient temperature of less 
uitable installation location. 

Do not operate the device in an environment in which, for example, acids are 
used to clean other parts. Various acids may cause pitting corrosion on device 

The device's installation location must be sufficiently stable, clean and 

All local applicable safety provisions and regulations must be complied 

Place device at its final location. For this, also see transport instructions in 

Device must be leveled out in all directions. 

Connect to power supply  

D A N G E R 

Electrical hazard 

This may result in fatal electrocution. 

Connect electrical connections in accordance with the 
wiring diagram and the information on the type plate.
Device must be connected to power supply outlets with 
isolated ground receptacles (PE) only! 
The mains plug serves as safe separation from mains.
and must always be freely accessible at any time.
Do not operate device with damaged power cord.
Power cord must be regularly inspected for damage.
No liability accepted in case of improper power connection!
In accordance with all valid standards at the installation 
location, for example VDE 0100, 

this may be done by a skilledelectrician only.  

The device must not be operated in a potentially explosive environment or where 

Its analysing performance is heavily limited with an ambient temperature of less 

Do not operate the device in an environment in which, for example, acids are 
used to clean other parts. Various acids may cause pitting corrosion on device 

sufficiently stable, clean and 

All local applicable safety provisions and regulations must be complied 

Place device at its final location. For this, also see transport instructions in 

Connect electrical connections in accordance with the 
wiring diagram and the information on the type plate. 

connected to power supply outlets with 

The mains plug serves as safe separation from mains. 
and must always be freely accessible at any time. 
Do not operate device with damaged power cord. 

inspected for damage. 
No liability accepted in case of improper power connection! 
In accordance with all valid standards at the installation 
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Power supply 
 

Note and observe information regarding power supply on the device's type plate and in 
wiring diagram. 
Before connecting to power power supply, check and observe the following: 
 On the building side, use delayed-action fuses only and an earth leakage circuit 
breaker (ELCB) with a tripping current of 30 mA max. 
On the building side, install a suitable line disconnecter before the plug connection. 
Check voltage. PE and neutral line must be dead! 
Check through connection of protective earth conductor system! 

 
 

5.3 Supplies 
 
Oils approved by Jörg Golombek 
 

Silicone oil  � "Type 350 for film analysis" 
from Jörg Golombek 

  
 
 

Use of other chemicals 
 
Jörg Golombek does not accept any liability for property damage resulting from 
the use of non-approved chemicals. 
 
Jörg Golombek may approve other chemicals on request. Any costs incurred for 
such approval by Jörg Golombek will be charged. 



Film analysis 

Page 24 of 68 

 
 

 
 

 

Hazardous Materials!

There is the risk of harmful reactions on skin, mucous 
membranes and eyes and property damage.

� When handling hazardous materials, it is essential to 
observe manufacturer's safety instructions in the safety 
data sheet.

� Wear eye and skin protection when handling hazardous 
materials.

� Do not eat, drink or smoke while working with it.
� Bind any spilled oi
� Observe all notes regarding proper disposal of residual 

amounts and containers.

 
 

5.4 Commissioning 
 
Carry out commissioning steps when you use the device for the first time or after it had been 
out of operation for a longer period of time (> 3 months).
 

 

 

First-time commissioning by specifically trained and instructed 
skilled personnel only. Observe operating manual and safety 
instructions of device and safety data sheets of supplies!
Do not operate 
dismounted! 

 

 
5.5 Preparations 
 
Procedure 
 

1. Switch off main switch.
2. Banish all unauthorised persons from the device area.
3. If necessary: Clean device.
4. Check the complete device visually.
5. Check energy supply.
6. Check fill levels of all supplies.

Fill level of cold bath liquid should be about 5
in the bath opening. 
Fill level of hot bath liquid should be about in the middle of the ring of 
borings in the bath opening. 

 

 

NOTE! 

W A R N I N G 

Hazardous Materials! 

There is the risk of harmful reactions on skin, mucous 
membranes and eyes and property damage. 

When handling hazardous materials, it is essential to 
observe manufacturer's safety instructions in the safety 
data sheet. 
Wear eye and skin protection when handling hazardous 
materials. 
Do not eat, drink or smoke while working with it. 
Bind any spilled oil using adequate agents. 
Observe all notes regarding proper disposal of residual 
amounts and containers. 

Carry out commissioning steps when you use the device for the first time or after it had been 
period of time (> 3 months). 

W A R N I N G 

time commissioning by specifically trained and instructed 
skilled personnel only. Observe operating manual and safety 
instructions of device and safety data sheets of supplies!
Do not operate device with protective enclosures or safety covers 

Switch off main switch. 
Banish all unauthorised persons from the device area. 
If necessary: Clean device. 
Check the complete device visually. 
Check energy supply. 
Check fill levels of all supplies. 
Fill level of cold bath liquid should be about 5 mm below the ring of borings 
in the bath opening.  
Fill level of hot bath liquid should be about in the middle of the ring of 
borings in the bath opening.  

When handling hazardous materials, it is essential to 
observe manufacturer's safety instructions in the safety 

Wear eye and skin protection when handling hazardous 

Observe all notes regarding proper disposal of residual 

Carry out commissioning steps when you use the device for the first time or after it had been 

time commissioning by specifically trained and instructed 
skilled personnel only. Observe operating manual and safety 
instructions of device and safety data sheets of supplies! 

device with protective enclosures or safety covers 

mm below the ring of borings 

Fill level of hot bath liquid should be about in the middle of the ring of 



   Film analysis  

 

 Page 25 of 68 

5.6 Switch on device and check function 
 
 

 
 
Turn on power switch on heating unit. Once the display reads "OFF", the tempering bath may 
be put in operation by pressing the OK button. Please also read the relevant notes in the 
JULABO manual. 
 

6 Operation of device 
 

6.1 Computer-aided measurement 
Please also read the relevant safety instructions i n the JULABO manual!  
 
After starting the film analysis program that runs in a Windows environment, an idle 
measurement is carried out automatically in order to allow zero suppression. 
For this, pay attention not to touch or even block the specimen holder of the measuring unit 
during this calibration process. 
 
During idle measurement, the following screen is displayed: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As soon as idle measurement is completed, the program displays the main screen. 
 
 
The program is now ready for operation. To start measuring, a specimen must be fitted to the 
measuring head. 



Film analysis 

Page 26 of 68 

 

6.2 First measurement 
 
To make a measurement, you will need a specimen. 
 
For this, you need the supplied punch and the steel rule. 
 
Punch out a piece of film for measuring. 
For this, place the steel rule on the film and insert both  
between the two thrust plates of the punch. Press down the  
lever to punch out the specimen. 
 
The size of the punched film specimen is 96 x 60 mm. 
 
Always note the orientation of the film fibres. 
Make sure that the fibre orientation of the specimen is always  
in direction of the stir head. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The paper's fibre orientation has certain influence on the measurement. In order to guarantee 
comparability of the measurements, you should always punch out specimens with the same 
fibre orientation. 
After preparing the specimen as described above and after calibration is complete, you may 
fix the specimen in the wire fork. 



  

 

 

 

 
 
 

Risk of trapping or drawing in of body parts by stirrer fork.

Body parts may be injured 

• Safety equipment (for example, fix covers) must be installed. 
These must not be removed, bypassed, circumvented or put 
out of operation.

• Defective protective or safety equipment must be replaced 
immediately. Device must be switched off and se
protective or safety equipment is replaced or installed.

• Do not touch any rotating parts!
 
 

 

 

 

High temperature hazard in tempering bath (200°C)

Risk of significant burns or scalding of skin or eyes!

• Do not reach 
• Avoid splattering of tempering fluid!
• Wear safety goggles!
• Wear heat

 
 

 
Make sure that the specimen is positioned exactly in the middle of the fork.
For orientation, you may use the punched slots in the specimen.
  

 

C A U T I O N 

Risk of trapping or drawing in of body parts by stirrer fork.

Body parts may be injured or crushed. 

Safety equipment (for example, fix covers) must be installed. 
These must not be removed, bypassed, circumvented or put 
out of operation. 
Defective protective or safety equipment must be replaced 
immediately. Device must be switched off and se
protective or safety equipment is replaced or installed.
Do not touch any rotating parts! 

W A R N I N G 

High temperature hazard in tempering bath (200°C)

Risk of significant burns or scalding of skin or eyes!

Do not reach into tempering bath! 
Avoid splattering of tempering fluid! 
Wear safety goggles! 
Wear heat-resistant gloves! 

Make sure that the specimen is positioned exactly in the middle of the fork.
For orientation, you may use the punched slots in the specimen. 
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Risk of trapping or drawing in of body parts by stirrer fork. 

Safety equipment (for example, fix covers) must be installed. 
These must not be removed, bypassed, circumvented or put 

Defective protective or safety equipment must be replaced 
immediately. Device must be switched off and secured until 
protective or safety equipment is replaced or installed. 

High temperature hazard in tempering bath (200°C)  

Risk of significant burns or scalding of skin or eyes! 

Make sure that the specimen is positioned exactly in the middle of the fork. 
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The screen now shows the main screen: 
 

 
 
 
The main screen shows 4 areas: 

a) Menu bar 
(File, Display graphs ..., Options, Utils, Info) 

b) Buttons for setting the current scope of time 
(2.5  5  10  25  50  100  250  500) 

c) Overview of 5 available boxes 
including enabling buttons (1 ... 5) 

d) Function buttons 
(Save, Load, Graphs, Box, and End) 

 
We would now like to guide you through the program as you proceed with the measurement 
as follows: 
 
Box:  A box can be seen as a container into which a graph can be loaded from the 

hard disk or where a new graph can be created based on a measurement.  At 
any given point of time, there will only be one active box. Most buttons or 
menu items relate to activities within the active box. 

 
After starting the program, the first box will be enabled. This is indicated by the violet 
highlighting. 
 
To enable a different box, move the cursor to the desired button (1 - 5) and click the left 
mouse button. 
 
Now, if another box is active, enable box 1. 
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To open the active box, move the cursor to the Box button and do a left-click. 
The Box window will be displayed: 
 

 
 
For statistical reasons and for archiving your data, you should try and complete this screen as 
good as possible. 
Enter a film or graph name into the Name field. This will be the name under which the graph is 
stored on the hard disk. 
To get to the next field, hit the Tab key or move the cursor to and left-click on the desired 
field. To get to the former field, hold down the Shift key  and hit the Tab key . 
Within a field, you may move around using the arrow keys (arrow left/right). 
If there is an error in the field, you may delete it by hitting the Del key  or the Backspace key .  
 
It is essential that you enter the correct value in the Paper basis weight field. 
The program needs this value to calculate correctly. If the Paper basis weight  field remains 
blank, the program will assume a raw weight of 80g/m². 
 
Once you've filled in all fields correctly, click on the Start measurement  button (upper right 
corner of box screen). 
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The screen now shows the measurement screen: 

 

 
 
 
The measurement screen shows a coordinate system where the x-axis shows the time in 
minutes and the y-axis the hardness. 
 
The measuring head and the specimen now sinks into the silicone oil bath that was heated to 
140°C. 
 
The measuring process can be tracked on the screen directly. 
 
If, after a specific time period as set in the program, the graph does not continue any longer, 
the measuring process can be cancelled by clicking the End measurement  button. 
The measuring head, together with the cured specimen, returns to its initial position. 
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By clicking the Return  button you will return to the main screen: 
 

 

 
 
 
 
The box overview now shows: 
 

a) Name of the graph 
The graph name is the name you previously entered in the box screen. 

b) A graph in the scope of time grid 
that means that the box contains a measured graph that was measured within the scope 
of time that is indicated just below the grid. 

c) A pen 
that means that box data was edited but not yet saved to the hard disk. 
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To display the measured graph on the screen or to print it, click on the Graphs  button. 
 
The Display Graphs screen appears: 
 

 

 
 
 
You would now like to print the graph and the calculated data. 
Check if your printer is switched on and check for paper. 
 
Click the Print  button; a dialog window will appear prompting you to confirm Print graph?  by 
clicking Ok-. 
 
By clicking the Return  button you will return to the main screen. 
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In order to save the graph in the current box to your hard disk, click the Save button in the 
main screen. 
 
The screen now displays the Save screen: 
 

 

 
 
 
The Save screen includes two list boxes: 

a) Directory list box 
It lists all directories in the program. 

b) Graphs list box 
It displays all graphs included in the selected directory. 

 
In order to save the measured graph under the name displayed in the field located in the 
bottom left corner, click on the directory in the directory list box in which the graph is to be 
saved. 
Now, the graphs list box displays all graphs included therein and the Save button becomes 
active. 
By clicking the Save button, the graph is saved and you will return to the main screen 
automatically. 
The main screen will not show a pen any longer in the box overview, that means that the 
measured graph has been saved. 
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6.3 Program description 

6.3.1 Basics 
 
Box:  A box can be seen as a container into which a graph/pattern can be 

loaded from the hard disk or where a new graph can be created based on 
a measurement. Most of the activities triggered by buttons or menu items 
relate to the active box. 

 
Graph/pattern:  If the same settings, limits or specimen data are used for different graph 

measurements, such data may be entered into a box and saved as a 
pattern, as a basis for future measurements. 
So, a graph is just the same as a measured pattern. 

6.3.2 Main screen 
 
 

 

6.3.2.1 Buttons for setting the current scope of time: 
The current scope of time is the period of time on which the graph measurement is based. 
However, if there is a graph in a box, the scope of time in which the graph was measured is 
maintained as the scope of time of the box, that means that there may be graphs with 
different scopes of time in the five available boxes. 
If graphs are displayed by clicking the Graphs  button, only such graphs are displayed whose 
scope of time is the same as the current scope of time. 

Menu bar Buttons Option buttons Box overview 
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6.3.2.2 Box overview 
Five boxes are available in the program. 
These boxes are enabled by clicking the relevant button (1 ... 5). 
 
The box overview includes: 

a) Activation button 

b) Name: 
Displays the name of the graph/pattern in this box. 

c) Limit file: 
Name of assigned limit file. 

d) Scope of time and status 
The scope of time corresponds to the current scope of time as long as there is no 
measured graph in the box. 
 
The grid diagram of the scope of time shows whether a graph or pattern exists in the 
box. 

Empty grid:  A pattern is in the box. 
Grid with graph: A graph is in the box. 

a) Pen: 
A pen is displayed on the right side of the box overview, indicating not yet saved 
changes to graphs/patterns. 

 

6.3.2.3 Button: Save 
Saves a graph/pattern of the current box to the hard disk (see 3.4.). 

6.3.2.4 Button: Load 
Loads a graph/pattern from the hard disk to the current box (see 3.5.). 

6.3.2.5 Button: Graphs 
Clicking the Graphs button displays all graphs whose scope of time is the same as the current 
scope of time. (see 3.6.) 

6.3.2.6 Button: Box 
Clicking the box button opens the current box. 
In the box, specimen data and measurement settings are entered/selected, measurements 
are carried out and results are displayed. (see 3.7.) 

6.3.2.7 Button: End 
By clicking the End  button, you exit the program. If there are any unsaved graphs/patterns in 
any box, there will be a prompt to confirm. 
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6.3.3 Main screen menu 

6.3.3.1 Menu item:  File > Save Graph/Pattern 
Saves a graph/pattern of the current box to the hard disk (see 3.4.). 

6.3.3.2 Menu item:  File > Load Graph/Pattern 
Loads a graph/pattern from the hard disk to the current box (see 3.5.). 

6.3.3.3 Menu item:  File > Delete Graph/Pattern in Box 
The graph/pattern of the current box is deleted; the specimen data and the measuring setting 
are reset to default settings. 
The status of the current box after deleting corresponds to that of a box after program start. 

6.3.3.4 Menu item:  File > Delete Graph/Pattern on Disk 
Delete a graph/pattern from the hard disk (see 3.8.). 

6.3.3.5 Menu item:  File > Directory Create  
Create a new directory. 
Allows creation of directories for saving limits, patterns and graphs. (see 3.9.) 

6.3.3.6 Menu item:  File > Directory Delete 
Delete an empty directory. 
Directories can be deleted only if they do not contain any files (limits, patterns, graphs). 
If you want to delete a directory, you must first delete all files contained therein. 

6.3.3.7 Menu item:  File > Limit Management 
This function allows assigning limits to results, before or after measuring a graph. (see 3.11.) 

6.3.3.8 Menu item:  File > End 
Click on End  in the file menu to exit the program. If there are any unsaved graphs/patterns in 
any box, there will be a prompt to confirm. 

6.3.3.9 Menu item:  Display Graphs 
In the menu, click on Display graphs  to display all graphs whose scope of time is the same 
as the current scope of time. (see 3.6.) 

6.3.3.10 Menu item:  Options > Setup printer 
If you have several printers connected to your computer and would like to use a printer for the 
film analysis software that is not your default printer, this screen allows you to select your 
printer. 
The Printer setup  screen is a Windows screen and offers further setting options, depending 
on the printer driver. 
For further information, see your Windows manual. 
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6.3.3.11 Menu item:  Options > Graph colour 
This option allows you to change the colour of the graph on the screen. 
First, select the menu item Graph colour . Another menu pops up, displaying existing boxes. 
Select the box, for which you would like to change the graph colour. 
In the colour dialog, you may now select the desired colour. 
Click Ok to confirm the change or Cancel  to cancel colour change mode and then return to 
the main screen. 
 
Note:  You graphic board may not support all of the colours offered. In such case, try 

another colour. 
 

6.3.3.12 Menu item:  Options > Other Settings  
This option allows you to adjust to your needs the line thickness for printing and screen 
display and the margins for printing. 
 
For adjusting the margins, you should note the following: 
 

Your printer's physical margins are fixed. You can't print beyond those. 
The values you enter do not account for such physical margins; the margins of your 
print depends on your entered values and such physical margins. 
To determine the physical margins of your printer, set all margins to "0" and print a 
graph. 

 
Click Ok to confirm the change or Cancel  to cancel the change of settings mode and then 
return to the main screen. 

6.3.3.13 Menu item:  Utils > Reorganise database 
When is a reorganisation of the database recommended? 

a) If error messages are displayed while reading or writing data from/to the hard disk, a 
reorganisation may be a remedy. 

b) Reading from / writing to the hard disk becomes time-consuming. 

c) After deleting many directories or data from the hard disk. 
 
Note:  Before you carry out a reorganisation, we urgently recommend backing up 

your film analysis software! 
 

6.3.3.14 Menu item:  Utils > Import graphs / patterns 
The Import window allows you to import graphs or patterns created with the DOS version of 
the film analysis software. (see 3.15.) 
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6.3.4 Screen:  Save 
 
 
 

 
 
 
 
 
The Save screen has five sections: 

a) Option buttons: Graph/pattern 

b) Directory list box 

c) Graphs/patterns list box 

d) Entry field for name 

e) Buttons: Return & Save 
 
The Save screen allows you to save a graph from a box as a pattern or as a graph on the 
hard disk. If there is a pattern in a box, such pattern may only be saved as a pattern on the 
hard disk. 
Option buttons are used to select whether a graph is saved as a graph or pattern. 
 
In the film analysis software, data is organised in a way that allows you to create custom 
directories for storing graphs or patterns. 

Option buttons Directory list box Graphs/patterns list box 

Buttons Name entry field 
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If you select the pattern option button, for example, the directory list box displays all available 
pattern directories. The same applies for the graph option button. 
 
 
If you highlight an entry (available directory) in the directory list box, the graphs/pattern list 
box shows all graphs/pattern stored in this directory. 
 
If you load a graph or pattern from the hard disk into a box and change any data, but not the 
name of the graph/pattern, and you want to save it, the directory and the graph/pattern names 
are shown as default in the respective list boxes when the Save screen opens. If, however, 
you want to have another name for the graph/pattern, just enter the new name into the entry 
field (bottom left) and click the Save button. 
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6.3.5 Screen:  Load 
 
 

 
 
The Load  screen has four sections: 

a) Option buttons: Graph/pattern 

b) Directory list box 

c) Graphs/patterns list box 

d) Buttons: Return & Load 
 
The Load  screen allows you to load a graph or pattern from your hard disk to one of the five 
available boxes. 
 
In the film analysis software, data is organised in a way that allows you to create custom 
directories for storing graphs or patterns. 
 
If you select the pattern option button, for example, the directory list box displays all available 
pattern directories. The same applies for the graph option button. 
 
If you highlight an entry (available directory) in the directory list box, the graphs/pattern list 
box shows all graphs/pattern stored in this directory. 
 
Now, to load a graph or pattern, select the directory and the desired file and confirm by 
clicking the Load  button. 
The Load  screen closes and the current box displays the selected graph or pattern. 
  

Option buttons Directory list box Graphs/patterns list box 

Buttons 



   Film analysis  

 

 Page 41 of 68 

6.3.6 Screen:  Display Graphs 
 
The Display Graph  screen allows you to display measured graphs on the screen and to print 
them on your printer. 
The Display Graph  screen shows a coordinate system where the x-axis shows the time in 
minutes and the y-axis the hardness. 
 

 
 
The Display Graph screen may be opened from the main screen or from the box screen. 
 
Opening from the main screen, clicking the Graphs button will display all graphs whose scope 
of time is the same as the current scope of time. For better differentiation of the graphs, they 
display in different colours. The legend pane in the bottom left corner shows the respective 
names. 
In the Options screen (menu item: Options > Other Settings ), you can set the line thickness 
for screen display and printing. 
 
The line colours are assigned to the boxes. The colour of a graph of a box may be changed 
under Options > Graph colour . 
 
Opening the Display Graph  screen from the Box  screen will only show the graph that is 
currently in such box, irrespective of the current scope of time. 
 
The displayed graphs will be printed by clicking the Print  button and confirming the Print 
graph?  prompt. 
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6.3.7 Screen:  Box 
 
 
 

 
 
 

6.3.7.1 Entry field for graph / pattern name 
The names entered here identifies the graphs and patterns when working with the film 
analysis program. 
This name displays in the Display graph  screen, on the print and in the box overview in the 
main screen. 
When the graph is saved to the hard disk, this name is displayed as default. It can be 
accepted or overwritten by another name. 
 

6.3.7.2 Entry field for specimen data 
You can enter the respective specimen data into these fields. 
This data, except for the paper weight, does not influence the measurement. However, for 
statistical reasons and for archiving your data, you should try and complete this screen as 
good as possible. 

The Paper basis weight entry field is used for measuring. If no value is entered here, the 
program automatically assumes a paper weight of 80 g/m².

Name entry field Buttons Entry fields for specimen data 
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6.3.7.3 Button:  Start measurement 
Starts measurement, taking into consideration the current scope of time, the paper weight and 
the measurement settings (Adjustments). Measurement  screen (see 3.12.). 
If there is an already measured graph in the box, a prompt will pop up to prevent any 
accidental overwriting of the graph. 

6.3.7.4 Button:  Adjustments 
Here you can set the measurement parameters. 
In many tests and based on our experience with the film analysis device, these parameters 
have been exactly adjusted to the program. If, for any reason, you would like to change any 
parameters, see 3.13 for more details about the Adjustments  dialog. 

6.3.7.5 Button:  Relate limit file 
This function allows assigning limits to results, before or after measuring a graph. (see 3.11.) 

6.3.7.6 Button:  Graphs 
Click the Graphs  button to display the graph in the box. Click the Print  button in the Display 
Graphs screen to print on the printer. (see 3.6.) 

6.3.7.7 Button:  Results 
This shows the results, limits and limit deviation of the graph. (see 3.14.) 

6.3.7.8 Button:  Return 
The Return  button will get you back to the main screen. 
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6.3.8 Screen:  Delete graph/pattern from hard disk 
 
 
 

 
 
The Delete  screen has four sections: 

a) Option buttons: Graph/pattern 

b) Directory list box 

c) Graphs/patterns list box 

d) Buttons: Return & Delete 
 
The Delete  screen is used to delete graphs or patterns from your hard disk, permanently. 
 
In the film analysis software, data is organised in a way that allows you to create custom 
directories for storing graphs or patterns. 
 
If you select the pattern option button, for example, the directory list box displays all available 
pattern directories. The same applies for the graph option button. 
 
If you highlight an entry (available directory) in the directory list box, the graphs/pattern list 
box shows all graphs/pattern stored in this directory. 
 
Now, to delete a graph or pattern from your hard disk, select the directory and the desired file 
and confirm by clicking the Delete  button. 

Option buttons Directory list box Graphs/patterns list box 

Buttons 
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6.3.9 Screen:  Create directory 
 
 

 
 
 
The Create directory  screen has four sections: 

a) Option buttons: Graph / Limits / Pattern 

b) Directory list box 

c) Entry field for directory name 

d) Buttons: New & Return 
 
The Create Directory  screen allows you to create any directory for graphs, patterns or limits. 
After selecting the required directory type, the directory list box will display all directories 
already created for the respective type. 
Enter the name of the new directory into the entry field and confirm by clicking the New 
button. 
The directory list box will display the new directory and it will be available in data management 
for storing graphs, limits or patterns. 
 
You can use the same names for directories of different types (graphs, patterns, or limits). 
The entry of names is case sensitive. 
 
Clicking the Return button will get you back to the film window, without creating a directory. 

Option buttons Directory list box 

Buttons Name entry field 
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6.3.10 Screen:  Delete directory 
 
 

 
 
 
The Delete directory  screen has three sections: 

a) Option buttons: Graph / Limits / Pattern 

b) Directory list box 

c) Buttons: Delete & Return 
 
The Delete Directory  screen allows you to delete any directory for graphs, patterns or limits. 
 
After selecting the required directory type, the directory list box will display all directories of 
the respective type that exist in data management. 
 
To delete a directory, highlight it in the directory list box and confirm by clicking the Delete 
button. 
 
The directory will be removed from the directory list box and data management. 
 
Clicking the Return button will get you back to the film window, without deleting a directory. 
 
Note:  A directory can be deleted only if the respective d irectory does not contain 

any graphs, patterns or limits any more. 
Therefore, delete all files first that exist in the  directory to be deleted. 

Option buttons Directory list box 

Buttons 
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6.3.11 Screen:  Limit management 
 

 
 
 
Limit management allows you to assign limits to graphs or graph results. Such limits must be 
entered and saved before they can be assigned. These limits are created in the program in 
form of a limit file. And limit files are stored in a limit directory. 
Creation and deletion of limit directories is done in directory management. 
 
Note:  Assigning a limit file to a graph does not assign t he limit file as such, 

but only the limits and the limit file name. 
If, for example, an assigned limit file is changed or deleted, the limits of 
the graph will be maintained as long as the changed  limit file is not 
reassigned. 

6.3.11.1 List box for directories and limit files 
For creating a new limit file, select the directory from the directory list box in which you would 
like to store the new limit file. 
 
For assigning, deleting or changing a limit file, choose the directory from the directory list box 
in which the limit file is stored and then, from the limit file list box, the required limit file. 
 
Use the buttons described in the following for triggering the various  
functions. 
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6.3.11.2 Button:  Assign 
Once a limit file is highlighted in the limit file list box, it can be assigned to the current graph. 
The upper and lower limits and any deviations from the actual value are shown in the printout 
of a graph and in the results pane of the box screen. 
 

6.3.11.3 Button:  Change 
Using the Change  button, you may change the limits in a limit file. The Change  button will be 
greyed out and not active until you highlight a limit file in the Limit file  list box. 
After clicking the Change  button, the limit management dialog box will appear. 
 

 
 
Here, you can enter the limits for the calculated results of a graph. 
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6.3.11.4 Button:  New 
 
Using the New button, you can create a new limit file. 
The new limit file can be stored in the directory highlighted in the directory list box. After 
clicking the New button, the following dialog box appears: 
 

 
 
 
Enter the required limits into the entry fields. Enter the name of the limit file into the Name 
field in the bottom left corner. 

6.3.11.5 Button:  Delete 
 
Deletes a limit file from the hard disk. 
Highlight the limit file to be deleted in the directory list box. 
After clicking the Delete  button, you will be prompted to confirm; after confirming, the 
highlighted limit file will be permanently deleted from the hard disk. 

6.3.11.6 Button:  Return 
By clicking the Return  button you will return to the screen from which you opened limit 
management. 
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6.3.12 Screen:  Measurement 
 

 
 
 
The measurement screen shows a coordinate system where the x-axis shows the time in 
minutes and the y-axis the hardness. 
 
The time corresponds to the scope of time selected in the main screen. 
 
You may stop a measurement early by clicking the End measurement  button. 
 
Clicking the Return  button will get you back to the main screen of this film analysis program. 
 
If a measurement is not stopped early, the window will close automatically upon the lapse of 
the total measuring time of the selected scope of time; the main screen will be displayed 
again. 
 
Since the actual measurement is a time-critical process, it is impossible to start other 
Windows applications or switch to running applications while the Measurement  screen is 
open. 
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6.3.13 Screen:  Adjustments 
 

 
 
 
The Adjustments  dialog allows you to set the parameters required for measurement. 
 
By clicking the OK button you activate the changed parameters and return to the Box  screen. 
 
Clicking the Cancel  button will discard all changes made and the former settings (before 
opening the dialog box) will be the valid parameters. 
 
In many tests and based on our experience with the film analysis device, these parameters 
have been exactly adjusted to the program. If, for any reason, you would like to change any of 
these parameters, we kindly ask you to note the effects listed below: 

a) Stirrer number: 
For specific applications, it may be necessary to work with a different measuring head; 
this can be noted in this field. 
Default setting: No. 1 

b) Voltage: 
The voltage influences the rotational speed of the stirrer fork. Usually, you would want to 
use the default settings that had been calculated based on the raw paper weight. For 
specific test specimens or for experimental purposes, these default settings may be 
changed. 
Possible values include: 2, 3, 4, 5, 6, 8, 10 Volts. 

c) Measuring cycle: 
The time interval between two stirrer fork rotations. For this setting, it is necessary to find 
a reasonable compromise between the number of measuring points, which are the result 
of each rotation, and the fact that the curing resin should be moved (disturbed) as little 
as possible to achieve a representative graph. 
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d) Viscosity: 
This is the viscosity of the test bath liquid at 20°C. 
Default setting is 350 mPas for the standard silicone oil. 

e) Amplification: 
If, for example, a specimen with differing dimensions is tested, it may be reasonable to 
adjust the graph height (curing axis) by this amplification value. 

f) Starting time: 
In order to disregard the motor's starting current during measurement, the actual 
measurement of the motor's current drain begins only after the starting time. 

g) Measuring time: 
After the starting time, the measuring time begins during which the current drain for 
rotating the specimen in the test bath is determined. 

h) No-load current: 
Indicates the measuring motor's current drain under no load. 

 
 
As soon as the program starts, the parameters will always be the default parameters. You can 
be sure that as long as you use these default settings, all measurements will produce 
reasonable results. We recommend always using these default parameters, except for 
experimental purposes, to guarantee comparability of measurements, yours and that of other 
users of the device. 
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6.3.14 Screen:  Results 
 

 
 
 
The Results  screen shows the calculated results of a graph and the limits assigned to the 
graph. 
 
If the result is within the minimum and maximum limits, deviation is 0. 
 
If the result is above the maximum limit or below the minimum limit, deviation is calculated 
based on the difference between the actual value and the related limit. 
The deviation's algebraic sign indicates whether the maximum limit is exceeded (positive) or 
the value falls below the minimum limit (negative). 
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6.3.15 Screen:  Import graphs/patterns 

 
 
The Import window allows you to import graphs or patterns created with the DOS version of 
the film analysis software. 
Imported files are stored in the Import directory. If such a directory is not existent, it will be 
created automatically. 
The naming convention is: ‘File name’->‘Graph name’ 
Measured graphs are stored as graphs in the Import directory; not measured graphs are 
stored as patterns in the Import directory. 

6.3.15.1 List box for drives, directories and graph files 
Use this list box to highlight the graph files you would like to import. 
The Graph file  list box offer several options for highlighting files: 

a) By clicking on the respective file: 
The respective file is selected for import. 

b) By clicking on the first file and another click on another file while holding down the 
SHIFT key: 
All files in between the two marked files are selected for import. 

c) By clicking on the first file and another click on a second file while holding down the 
CTRL key: 
For selecting specific individual files for import. If several files have been selected, you 
can deselect a file by holding down the CTRL key and clicking on the file again. 

Clicking on the OK button will start the import process. 
Imported files may then be loaded to the desired boxes using the Load  button. 
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6.4 Result analysis 
 

6.4.1 Maximum curing speed after:    [ Minutes ] 
 
 
This means the point of time where the reactivity (gradient of the graph) is the highest. 
 
This is the point of time that is identical to the turning point of the graph. 
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6.4.2 Curing time:    [ Minutes ] 
 
 
The curing time is the point of time where the graph has reached 95 % of the maximum 
hardness. 
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6.4.3 Curing speed 
 
 
The curing speed indicates the maximum reactivity of the specimen. 
 
Its value is calculated based on the maximum gradient of the graph that occurs at the turning 
point. 
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6.4.4 Flow time [ Seconds ] 
 
 
The flow time is the period ending at the lowest point, where the graph exceeds the lowest 
point + 4 % of the maximum. 
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6.4.5 Flexibility [ % ] 
 
 
Flexibility is calculated based on the minimum and maximum values. 
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6.5 Switch off device in case of emergency (Emergency S top)
 
Besides the controlled shutting down of the device, it may also be switched off immediately in 
case of emergency. For this, switch off the main switch.
 

 

� If there is a risk of personal injury or another emergency 
situation, the main switch / EMERGENCY STOP  must be 
switched to OFF immediately.
 

 

6.6 Restart after stop 
 

 
 
 

The required measures for restarting the device after a stop are 
dependent on the cause of the stop.
 
 
In case of any malfunction, switch the main switch to OFF.

 

6.7 Switch off device 
 
Prerequisites 

 Measurement is complete.
 

Procedure 
 

1 Switch off main switch.
2 Cover bath opening.

 
 
 
 
 
 
 
 
 
 

Switch off device in case of emergency (Emergency S top)

Besides the controlled shutting down of the device, it may also be switched off immediately in 
emergency. For this, switch off the main switch. 

C A U T I O N 
If there is a risk of personal injury or another emergency 
situation, the main switch / EMERGENCY STOP  must be 
switched to OFF immediately. 

C A U T I O N 

The required measures for restarting the device after a stop are 
dependent on the cause of the stop. 

In case of any malfunction, switch the main switch to OFF.

Measurement is complete. 

off main switch. 
Cover bath opening. 

Switch off device in case of emergency (Emergency S top)  

Besides the controlled shutting down of the device, it may also be switched off immediately in 

If there is a risk of personal injury or another emergency 
situation, the main switch / EMERGENCY STOP  must be 

The required measures for restarting the device after a stop are 

In case of any malfunction, switch the main switch to OFF. 



   Film analysis  

 

 Page 61 of 68 

6.8 Test and examine safety equipment 
 

 

NOTE!  

The test and safety equipment must be checked regularly, if possible daily 
or prior to operation. 
 
Defective protective or safety equipment must be replaced immediately. 
 
Device must be switched off and secured until protective or safety 
equipment is replaced or installed. 
 
Any manipulation or bypassing of protective or safety equipment is 
prohibited and may result in legal consequences. 
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7 Cleaning, maintenance
 

7.1 Maintenance intervals
Maintenance is required no later than every 12 months. Maintenance details may be 
requested from Jörg Golombek. Jörg Golombek also carries out maintenance jobs, if ordered.

 

7.2 Maintenance 
 
Maintenance must be carried out in accordance with the device's maintenance instructions.
The device operator is responsible for the scope and execution of maintenance work.
 

7.3 Cleaning 
 

 

Cleaning agents and cleaning procedures not suited for the 
device may cause heavy damage to the device. 

 

 
 
 

� Before you start any cleaning procedure, switch the main 
switch / EMERGENCY STOP to OFF.

� Do not clean device with heated steam or solvents.
� Before you clean the device (for example, with water), for 

reasons of safety and function, make sure that no liquids will 
penetrate through openings (cover openings, if necessary). 
This applies specifically for electric motors and switch 
cabinets.

� Do not use metal objects for removing dirt.
� Do not use high
� Let device cool down before cleaning. Completely remove 

all added covers after cleaning.

 
 
 
 
 
 
 
 
 
 
 

Cleaning, maintenance  

Maintenance intervals  
Maintenance is required no later than every 12 months. Maintenance details may be 
requested from Jörg Golombek. Jörg Golombek also carries out maintenance jobs, if ordered.

be carried out in accordance with the device's maintenance instructions.
The device operator is responsible for the scope and execution of maintenance work.

C A U T I O N 

Cleaning agents and cleaning procedures not suited for the 
device may cause heavy damage to the device.  

Before you start any cleaning procedure, switch the main 
switch / EMERGENCY STOP to OFF. 
Do not clean device with heated steam or solvents.
Before you clean the device (for example, with water), for 
reasons of safety and function, make sure that no liquids will 
penetrate through openings (cover openings, if necessary). 
This applies specifically for electric motors and switch 
cabinets. 

use metal objects for removing dirt. 
Do not use high-pressure cleaners for cleaning bearings.
Let device cool down before cleaning. Completely remove 
all added covers after cleaning. 

Maintenance is required no later than every 12 months. Maintenance details may be 
requested from Jörg Golombek. Jörg Golombek also carries out maintenance jobs, if ordered. 

be carried out in accordance with the device's maintenance instructions. 
The device operator is responsible for the scope and execution of maintenance work. 

Cleaning agents and cleaning procedures not suited for the 

Before you start any cleaning procedure, switch the main 

Do not clean device with heated steam or solvents. 
Before you clean the device (for example, with water), for 
reasons of safety and function, make sure that no liquids will 
penetrate through openings (cover openings, if necessary). 
This applies specifically for electric motors and switch 

pressure cleaners for cleaning bearings. 
Let device cool down before cleaning. Completely remove 



  

 

7.4 Checks 
 

 

 
 

 

Mechanical or electrical 
equipment.

This may result in most severe or fatal injuries.

Safety equipment must not be removed, bypassed, circumvented 
or put out of operation. It must be checked for proper function and 
operability on a daily 
retrofitting, overhauling or repair work on the machine or the 
switch cabinet.
Any identified defects must be repaired immediately.

 

 

The works listed below must be carried out by persons only 
fulfill the stated minimum requirements:
� Mechanics (work on the mechanical parts)
� Electrically qualified persons (work on the electric parts)
� Operators that have the necessary skills, after being instructed 

(individual work)
 
 

7.5 Special tools 

 

� No third
without prior checks by and consent of Jörg Golombek.

� Special tools are not required.

 
 

7.6 Preventive maintenance

 

� After carrying out mechanical or electrical work on the device, 
you must ensure that all and any intended safety equipment is 
fully functional 

 

 

D A N G E R 

Mechanical or electrical hazards through manipulated safety 
equipment. 

This may result in most severe or fatal injuries.

Safety equipment must not be removed, bypassed, circumvented 
or put out of operation. It must be checked for proper function and 
operability on a daily basis. This applies specifically after 
retrofitting, overhauling or repair work on the machine or the 
switch cabinet. 
Any identified defects must be repaired immediately.

W A R N I N G 

The works listed below must be carried out by persons only 
fulfill the stated minimum requirements: 

Mechanics (work on the mechanical parts) 
Electrically qualified persons (work on the electric parts)
Operators that have the necessary skills, after being instructed 
(individual work) 

C A U T I O N 

No third-party assemblies must be fitted to the device 
without prior checks by and consent of Jörg Golombek.
Special tools are not required. 

Preventive maintenance  

C A U T I O N 

After carrying out mechanical or electrical work on the device, 
you must ensure that all and any intended safety equipment is 
fully functional again. 
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hazards through manipulated safety 

This may result in most severe or fatal injuries. 

Safety equipment must not be removed, bypassed, circumvented 
or put out of operation. It must be checked for proper function and 

basis. This applies specifically after 
retrofitting, overhauling or repair work on the machine or the 

Any identified defects must be repaired immediately. 

The works listed below must be carried out by persons only that 

Electrically qualified persons (work on the electric parts) 
Operators that have the necessary skills, after being instructed 

party assemblies must be fitted to the device 
without prior checks by and consent of Jörg Golombek. 

After carrying out mechanical or electrical work on the device, 
you must ensure that all and any intended safety equipment is 
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� Any defective or worn parts must be replaced immediately in 
order to prevent 

� All required maintenance work on additional units must be 
carried out in accordance with their manufacturers' 
instructions (for example, drive motors, heating unit).

 

 
 

7.7 Corrective maintenance

 
 
 

In case of any malfunction, turn main switch to OFF and 
disconnect all power cords from mains.
Access to the switch cabinet must be restricted to persons
with the relevant technical training only.
After carrying out corrective maintenance work on 
you must ensure that all and any intended safety equipment is 
fully functional again. Minor mechanical repairs without influence 
on the device safety may be carried out by the machine operator 
on his/her own, if such personnel is skilled and qu
out such repairs in line with generally accepted technical 
standards. Jörg Golombek does not accept any liability for any 
malfunctions resulting thereof or any consequential damage.

The following must be carried out by specialist personnel
Jörg Golombek only:

� Changes to the device's basic settings.

 

8 Troubleshooting, error messages
 
8.1 Safety instructions 

� While finding causes for malfunctions or errors, the device may still be 
energised, therefore you must act with special care.

� For remedying faults or errors, the device MUST be shut off and 
disconnected from mains; it must be protected against accidental switching 
on. 

� Before switching on again, check for correct wiring and connection. 
� Inspect safety equipment.
�  

C A U T I O N 

Any defective or worn parts must be replaced immediately in 
order to prevent consequential damage or extra downtimes.

All required maintenance work on additional units must be 
carried out in accordance with their manufacturers' 
instructions (for example, drive motors, heating unit).

Corrective maintenance  

C A U T I O N 

In case of any malfunction, turn main switch to OFF and 
disconnect all power cords from mains. 
Access to the switch cabinet must be restricted to persons
with the relevant technical training only. 
After carrying out corrective maintenance work on the device, 
you must ensure that all and any intended safety equipment is 
fully functional again. Minor mechanical repairs without influence 
on the device safety may be carried out by the machine operator 
on his/her own, if such personnel is skilled and qualified to carry 
out such repairs in line with generally accepted technical 
standards. Jörg Golombek does not accept any liability for any 
malfunctions resulting thereof or any consequential damage.

The following must be carried out by specialist personnel
Jörg Golombek only: 

Changes to the device's basic settings. 

error messages  

While finding causes for malfunctions or errors, the device may still be 
energised, therefore you must act with special care. 

remedying faults or errors, the device MUST be shut off and 
disconnected from mains; it must be protected against accidental switching 

Before switching on again, check for correct wiring and connection. 
Inspect safety equipment. 

Any defective or worn parts must be replaced immediately in 
consequential damage or extra downtimes. 

All required maintenance work on additional units must be 
carried out in accordance with their manufacturers' 
instructions (for example, drive motors, heating unit). 

In case of any malfunction, turn main switch to OFF and 

Access to the switch cabinet must be restricted to persons 

the device, 
you must ensure that all and any intended safety equipment is 
fully functional again. Minor mechanical repairs without influence 
on the device safety may be carried out by the machine operator 

alified to carry 
out such repairs in line with generally accepted technical 
standards. Jörg Golombek does not accept any liability for any 
malfunctions resulting thereof or any consequential damage. 

The following must be carried out by specialist personnel from 

While finding causes for malfunctions or errors, the device may still be 

remedying faults or errors, the device MUST be shut off and 
disconnected from mains; it must be protected against accidental switching 

Before switching on again, check for correct wiring and connection.  



  

 

8.2 Indicate and cor
 
Correction of faults and errors MUST be carried out by authorised skilled personnel 
only. 

 

8.3 Error messages and troubleshooting
 

� Malfunctions or errors are indicated by error messages on the device 
controller.

� Malfunctions and errors MUST be
� For all work correcting malfunctions or errors, switch off the device and 

disconnect from mains, protect against accidental switching on.
� Restart the device only after correction of malfunction / error and if 

protective and safety equipment is functional and operable.
 

9 General information
 

 
 

 
 

Troubleshooting or reaching into the direct hazard zone of the 
device is allowed only with the main switch/EMERGENCY STOP 
switched to OFF.
 
If the 
incompletely or faultily, any residues of cleaning agent must be 
thoroughly removed from the wheel (rinse with fresh water 
manually).
Otherwise, there is the risk of damage to the wheel, especially 
the rim. 
Jörg Golombek does not accept any liability for this.

 

10 Safety equipment
 

 

 
 

� Safety equipment must not be made ineffective. This applies 
in any case.

� Any damage to it must be reported immediately.

� Stop operation of the device until 
protect against accidental switching on.

 
 

 

Indicate and cor rect faults 

Correction of faults and errors MUST be carried out by authorised skilled personnel 

Error messages and troubleshooting  

Malfunctions or errors are indicated by error messages on the device 
controller. 
Malfunctions and errors MUST be corrected by authorised personnel only.
For all work correcting malfunctions or errors, switch off the device and 
disconnect from mains, protect against accidental switching on.
Restart the device only after correction of malfunction / error and if 

tive and safety equipment is functional and operable.

General information  

C A U T I O N 
Troubleshooting or reaching into the direct hazard zone of the 
device is allowed only with the main switch/EMERGENCY STOP 
switched to OFF. 

If the AUTOMATIC program sequence is interrupted, runs 
incompletely or faultily, any residues of cleaning agent must be 
thoroughly removed from the wheel (rinse with fresh water 
manually). 
Otherwise, there is the risk of damage to the wheel, especially 
the rim.  
Jörg Golombek does not accept any liability for this.

Safety equipment  

C A U T I O N 
Safety equipment must not be made ineffective. This applies 
in any case. 

Any damage to it must be reported immediately.

Stop operation of the device until damage is repaired and 
protect against accidental switching on. 
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Correction of faults and errors MUST be carried out by authorised skilled personnel 

Malfunctions or errors are indicated by error messages on the device 

corrected by authorised personnel only. 
For all work correcting malfunctions or errors, switch off the device and 
disconnect from mains, protect against accidental switching on. 
Restart the device only after correction of malfunction / error and if 

tive and safety equipment is functional and operable. 

Troubleshooting or reaching into the direct hazard zone of the 
device is allowed only with the main switch/EMERGENCY STOP 

AUTOMATIC program sequence is interrupted, runs 
incompletely or faultily, any residues of cleaning agent must be 
thoroughly removed from the wheel (rinse with fresh water 

Otherwise, there is the risk of damage to the wheel, especially 

Jörg Golombek does not accept any liability for this. 

Safety equipment must not be made ineffective. This applies 

Any damage to it must be reported immediately. 

damage is repaired and 
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11 Service by Jörg Golombek 

Customer service 
Jörg Golombek 
Eichhäldenstr. 73 
D-71720 Oberstenfeld 
Telephone +49 (0) 7062 5607 
Fax +49 (0) 7062  3873 
Email: info@folienanalyse.de 

 
 

12 Supplier's liability 
 

� Notification of any defect must be made to us without delay, but no later than 10 days 
from receipt of the goods.  
 

� Fitness for a specific purpose is guaranteed only if Jörg Golombek confirms such 
fitness in writing.   
 

� Jörg Golombek does not guarantee that the deliverable can be used at the location 
intended by the customer. Including but not limited, the customer must clarify in 
advance whether the relevant municipality allows dumping waste water into the 
sewage system if the deliverable is used or if it requires any water treatment. Jörg 
Golombek is not responsible for any damage caused if the deliverable is used despite 
conflicting conditions on site and is not liable to pay any damages. 

 
� The technical data included in the product description also contain information as 

regards approved consumables (for example, cleaning agents). If other material is 
used than described therein or material of different composition, any resulting or 
caused damage shall not result in any damage claims against Jörg Golombek. Any 
liability in this regard shall be excluded. 

 
� In case of injury to life, body or health resulting from any negligent breach of duty on 

the part of Jörg Golombek or intentional or negligent breach of duty on the part of the 
legal representatives or employees of Jörg Golombek, Jörg Golombek shall be liable 
as provided by the law. The same applies for other damage resulting from grossly 
negligent breach of duty on the part of Jörg Golombek or intentional or grossly 
negligent breach of duty on the part of the legal representatives or employees of Jörg 
Golombek. For any other damage resulting from the breach of material obligations, 
which are the consequence of ordinary negligence or negligent breach of duty of the 
legal representatives or employees of Jörg Golombek, liability shall be limited to 
foreseeable, typical damage up to the value of the subject matter of the sales contract. 
Excluded shall be damage claims for other damage in case of violations of secondary 
obligations resulting from ordinary negligence. Jörg Golombek shall not be liable for 
other damage from default resulting from ordinary negligence; this does not affect the 
customer's statutory rights after expiration of a reasonable grace period. Any further 
claims for damages, reduction of payment or withdrawal from contract shall be 
excluded; the same applies for claims for compensation of any indirect damage or 
damage that exceeds the value of the shipment. Above disclaimers or limitations of 
liability shall not apply if Jörg Golombek has fraudulently concealed any defect or if a 



  

 

specific property or quality of the deliverable is guaranteed by contract. Customer's 
claims for compensation of useless expenses instead of damages in place of 
performance shall remain unaffected.

 
� Claims under above paragraph shall be subject to the statute of limitations. All other 

claims of the customer shall become statute
 
 
 

13 Sub-supplier documentation
 
For third party devices or functional units installed in 
by their respective suppliers applies. Such data sheets, catalogues, operating manuals, tables 
or descriptions are attached.

� Julabo Circulator 

 

 
 

� Safety instructions and warnings of third manufacturer
be observed.

 
 
 
 

 
  

 

specific property or quality of the deliverable is guaranteed by contract. Customer's 
claims for compensation of useless expenses instead of damages in place of 
performance shall remain unaffected. 

r above paragraph shall be subject to the statute of limitations. All other 
claims of the customer shall become statute-barred after expiration of 12 months' time. 

supplier documentation  

For third party devices or functional units installed in this device, the documentation supplied 
by their respective suppliers applies. Such data sheets, catalogues, operating manuals, tables 
or descriptions are attached. 

C A U T I O N 

Safety instructions and warnings of third manufacturer
be observed. 
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specific property or quality of the deliverable is guaranteed by contract. Customer's 
claims for compensation of useless expenses instead of damages in place of 

r above paragraph shall be subject to the statute of limitations. All other 
barred after expiration of 12 months' time.  

this device, the documentation supplied 
by their respective suppliers applies. Such data sheets, catalogues, operating manuals, tables 

Safety instructions and warnings of third manufacturer must 
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14 Declaration of conformityFilm analysis 
 

EC Declaration of Conformity 
 

For the purpose of the EC directives on  
 

⌧⌧⌧⌧ Machinery 2006/42/EC, Annex II 1A 
⌧⌧⌧⌧ Low voltage 2006/95/EC 
 

Type of machine 
 

Make:  Device for Film Analysis 
 

Art. No.  
 
 

Has been developed, designed and manufactured in accordance with above directives, in the 
sole responsibility of 
 

Company :  Jörg Golombek 
 Eichhäldenstr. 73 
 71720 Oberstenfeld 
 
 

The following harmonised standards have been applied: 
 

⌧⌧⌧⌧ DIN EN 953, Safety of machinery – Guards 
⌧⌧⌧⌧ DIN EN ISO 12100-1-2, Safety of machinery 
⌧⌧⌧⌧ DIN EN ISO 13849-1, Safety of machinery – safety-related parts of control systems 
⌧⌧⌧⌧ DIN EN 60204-1, Electrical equipment of machines 
⌧⌧⌧⌧ DIN EN ISO 13857, Safety distances to prevent hazard zones being reached by upper 

and lower limbs 
⌧⌧⌧⌧ DIN EN ISO 13850, Safety of machinery – Emergency Stop - Principles for design 
⌧⌧⌧⌧ DIN EN 349 Safety of machinery – Minimum gaps to avoid crushing of parts of the 

human body 
 
 
 
 

Name and address of person responsible for documentation: 
 

Name: 
Place: Street: 
Telephone: 
 
 

The operating manual for the device is present. 
 as original version (German) 
 as translated version (English) 

 
 
 
 
 
 

 ..............................................................................................................................................  
Place, Date   Signature Information about signatory 
 


